APA Style Guide

The following are examples and explanations that follow the Publication Manual of the American Psychological Association (6th ed., 2010) and the APA website <http://www.apa.org> for revisions. This handout is intended as a guide. If you have specific questions, always check with your instructor.

**Note: Examples in this handout may be single-spaced to conserve paper. ALWAYS double-space between ALL lines.**

General Rules for APA format

- A reference citation must follow each quote, paraphrase, or idea you borrowed from another source.
- A list of references must follow your paper. Only list references that you referred to in the text of your paper.

Reference Citations in Text

Reference citations give brief information about an original source you are quoting or paraphrasing in the text of your paper. This allows your audience to see where the information is coming from, while also giving credit to the original source.

Information Needed for Reference Citations in Text
- Author’s last name
- Publication Date
- Page number (used for direct quotations)

One Work by One Author

**Rules**

- If the name of the author appears in the sentence, cite only the year of publication in parentheses.
- If you do not introduce the author’s name, place both his/her last name and the year, separated by a comma, in parentheses.
- Within a paragraph, you do not need to include the year in additional references to the author’s work, as long as the work cannot be confused with other citations.
- Material directly quoted from the author must be enclosed in quotation marks. The author’s last name, date of publication, and page number of the quotation should appear in parentheses at the end of the quote.
- To cite information from the DSM-IV in the text of your paper, cite the name of the association in full for the first quote or paraphrase. For each additional time you quote or paraphrase from the DSM, you may refer to it in shortened form.

**Examples**

- According to Gardner (1983), there are multiple forms of intelligence.
- Multiple intelligence theory suggests that seven types of intelligence exist (Gardner, 1983).
- According to Gardner (1983), there are multiple forms of intelligence. Gardner believes that as many as seven types…
- In multiple intelligence theory “a human intellectual competence must entail a set of skills of problem solving” (Gardner, 1983, p. 60).
- “Obsessions are persistent ideas, thoughts, impulses…” (American Psychiatric Association, Diagnostic and Statistical Manual of Mental Disorders, 2000, p. 457).
One Work by Multiple Authors

Rules
- If quoting or paraphrasing a work by two authors, always cite both names.
- If quoting or paraphrasing a work that has three, four, or five authors, cite all authors the first time the reference occurs. In additional citations, include only the last name of the first author listed followed by et al.
- If citing a work that has six or more authors, use only the last name of the first author listed followed by et al.

Examples
- In the book *Guiding Young Children*, the authors state that “the goal of discipline is for children to achieve self-control” (Gordon & Browne, 1996, p. 15).
- Through their examination of several research studies, Vermette, Harper, and DiMillo (2004) prove that cooperative learning works. However, Vermette et al. acknowledge that most research on cooperative learning has focused on older children.
- A recent study on Early Head Start claims that “children living in poverty, especially pre-school age children, are at great risk for poor developmental outcomes” (Peterson et al., 2004, p. 76).

Works with No Author

Rules
- When the work you are quoting or paraphrasing has no author, cite the first few words of the title and the year of publication. Use quotation marks around the title of a journal article or chapter of a book. Italicize the title of a book or report.
- If the work you are using indicates that the author is “Anonymous,” cite the word Anonymous followed by the date, and page number (if a direct quote).

Examples
- “Death penalty opponents says teens who are too young to vote or drink alcohol are too young to be executed” (“Should He Die?”, 2004, p.1).

Personal Communications (Interviews, E-mails, Letters, Memos, Telephone Conversations, etc.)

Rules
- Cite personal communications in the text of your paper only. You do not need to include them as an entry in your reference list.

Examples
- (G.Caliguiri, personal communication, September 28, 2004).

Electronic Sources (Websites, Online Articles, Online Reports, etc.)

Rules
- Since many electronic sources do not provide page numbers, count the number of paragraphs on the webpage and indicate which paragraph the information you are citing appears. If the online document is in PDF format, use the page numbers indicated on the document.

Examples
- “The brain’s center of reasoning and problem solving is among the last to mature” (Thompson, 2004, para. 1).

Long Quotations (any direct quotations of 40 or more words)

Rules
- Display a long quotation by starting a new line, set off from the paragraph. Quote should be double-spaced. Indent the block about 5 spaces or ½ inch.

Examples
- The USA PATRIOT ACT: ...grants federal officials greater powers to trace and intercept terrorists’ communications both for law enforcement and foreign intelligence purposes. It re-enforces federal anti-money laundering laws and regulations in an effort to deny terrorists the resources necessary for future attacks. It tightens our immigration laws to close our borders to foreign terrorists and to expel those among us (Doyle, 2002, p. 1).
Reference List

The reference list at the end of your paper lists all the information needed to identify and find the sources you cited in the text of your paper.

General Rules

- Do not list personal communications such as interviews, letters, e-mails etc.
- Type the word “References” at the top of a new page.
- Double-space all entries.
- Alphabetize your entries by author’s last name or by title if no author is given.
- Indent the second and any following lines (use the tab button on your keyboard) of each entry.
- Capitalize only the first word of the title and subtitle of books and articles.
- Italicize titles of books and journals.
- Use initials for author’s first name.
- If you are listing more than one source from the same author, arrange them by year of publication, the earliest first.

References to Entire Books

One Author


Two to Six Authors


Note: List by last names and initials; commas separate author names, while the last author name is preceded again by ampersand.

Seven or More Authors

Note: List by last names and initials; commas separate author names. After the sixth author’s name, use an ellipses ( . . . ) in place of the author names. Then provide the final author name. There should be no more than seven names.

Edited Book


Diagnostic and Statistical Manual of Mental Disorders (DSM-IV-TR)


References to an Article, Essay, or Chapter in a Book

Essay or Chapter in an Edited Book


Note: For an essay or chapter in a book with no editor, include the word In before the book title.
Essay in an Encyclopedia


Note: If an entry has no author, place the title in the author position.

References to Periodicals (Journals, Magazines, and Newspapers) in Print

- Capitalize the entire name of the periodical.
- Give the volume number if available. Do not use an abbreviation such as Vol. Give the issue of the periodical if that issue begins on page 1. Put the issue number in parentheses immediately after the volume number without a space.
- If the periodical does not use volume numbers, include the month, season or other date used. For example: (2004, June).
- Italicize the name of the periodical and the volume number, if given.
- Use pp. before the pages numbers for newspaper articles. For magazine or journals use numbers only.

Journal Article, One Author


Journal Article, Two to Six Authors


Note: If an article has more than seven authors, list the names of the first six authors followed by an ellipses (...) and then the last author's name.

Magazine Article


Note: Give the date shown on the publication—give the month for monthly magazines and month and day for weekly magazines.

Electronic Sources

- Direct readers as closely as possible to the information being cited. If possible, reference specific documents, or articles rather than an entire website.
- Provide web addresses that work; the web address is how your readers will find your cited material. Double-check the web addresses and URLs listed in your references to make sure they are up-to-date.

Journal Articles Retrieved from Library's Online Databases

Journal Article with a DOI (Digital Object Identifier)


**Note:** Use the article’s DOI (Digital Object Identifier), the unique code given by the publisher to a specific article. This can usually be found at the top of the page. Use the journal’s home page URL (or web address) if there is no DOI.

Internet Articles Based on a Print Source


Article in an Internet-only Journal


Document Available on a University, Government or Organization’s Website


**Note:** If a document is part of a larger website, identify the host organization and the relevant program or department before giving the web address for the specific document. Put a colon before the web address.

Formatting the Paper in APA Style

Below are guidelines for formatting your paper in APA style. In true APA format, an abstract or summary of your paper appears before the body. Ask your instructor if he/she requires an abstract. See 5.16 in the APA *Publication Manual* for guidelines.

Margins

Use 1 inch margins all around. To adjust margins in Microsoft Word, go to the *Page Layout* tab at the top of the screen and click on the *Margins* button. Under Margins, choose *Normal* from the menu.

Spacing

Double-space the text of your paper and your reference list.

Paging

A shortened version of the title of your paper should appear on the top left of every page and a page number should appear on the top right corner of every page (starting with the title and continuing through the reference list). The shortened title and page number should appear ½” from the top of each page.

If you are using Microsoft Word, you can insert the shortened title and page number by going to the *Insert* tab and clicking on the *Header* button. Choose the first option on the menu and type in a shortened version of your paper title. Next tab over to the right side of the page. To place the page numbers on the top right side of the page, click on the *Page Number* button. Choose the *Current Position* option and choose the first option which is plain number. Click the
**Close Header and Footer** button. The shortened title and page numbers should now appear consecutively throughout your document.

**Title Page**  
Type the full title of your paper on the top half of the page, followed by your name, the course title, your instructor’s name, and the date. All information should be centered horizontally and double-spaced.

To center your text in Microsoft Word, go to the Home tab and click on **Paragraph** menu. Under the **Indents and Spacing** tab choose “centered” from the **Alignment** pull-down menu and then click OK.

**Body**  
Begin with typing out your full title and centering it on the top of the page. Hit the enter or return button once and begin typing the body of your paper. Indent each paragraph by hitting the tab button once. Double-space the entire text.

See back page for sample title, body, and reference pages.
Examples

Title Page

Running Head: TITLE 1

<Centered>

Title
Name
Course Name
Instructor’s Name
Date

<Centered>

Body

Title 2

Use a readable font (e.g. Arial, Times New Roman) and type size (e.g. 12 point). Keep all margins 1 in. Double-space throughout your paper including quotations and the list of works cited.

Reference List

Title 4

References


Body

Title 3

Title of Paper

Indent each paragraph ½ in or five spaces. Put shortened title and page number ½ in. from top of each page justified to the right margin.